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 نگاه اجمالی به مباحث دوره
 

 فصل اول
 بررسی مباحث مرتبط با متون و معرفی تکنیک های مرتبط به آن

 

 فصل دوم
 بررسی مباحث مرتبط با جلوه های گرافیکی رو تصاویر و عکس ها

 

 فصل سوم
 بررسی مباحث مرتبط با عکاسی و تکنیک های مختص آن

 

 فصل چهارم
 (بعدی3) 3Dمبحث  بررسی مباحث مرتبط با
 

 فصل پنجم
 (طراحی قالب سایت و بنرهای تبلیغاتی متحرک)کاربردهای فتوشاپ در طراحی وب 
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 فتوشاپ در قالب تکنیک ها دوره آموزشی
 لرن سون سایت وب کاربران و دوستان تمام خدمت سلام با•

 یک با تا شدیم آن بر شخصی و روزمره های استفاده چه و کار بازار عرصه در چه گرافیک مبحث اهمیت به توجه اب•
 بوده این ما سعی تمام آموزشی دوره این در . باشیم عزیزان شما خدمت در فتوشاپ کاربردی کاملا و آموزشی دوره

  در قدرتمند بسیار افزار نرم این با را شما متعدد و گوناگون های پرژوه انجام قالب در  ها روش ترین ساده با که
 بتوانند دوره پایان در نیز ندارند افزار نرم این با آشنایی هیچ حتی که دوستانی که بطوری کنیم آشنا گرافیک  عرصه

  مجموع در و پراستفاده و کاربردی پروژه 80  انجام قالب در که دوره این در. کنند کار افزار نرم این با راحتی به
 می مجزا پروژه یک قالب در که هرجلسه در را شما است شده تهیه گرافیک زمینه در  آموزش ساعت  70از بیش
 شامل فصل هر که باشد می مجزا فصل 4 شامل دوره این.نمود خواهیم آشنا آن خاص های تکنیک و ها ابزار با باشد

 شد خواهد داده آموزش آنها در که مواردی و فصول این معرفی به ادامه در که باشد می خود به مختص های تکنیک
 به بتوانید و بپیوندید افزار نرم این ای حرفه کاربران جمع به هم شما دوره این پایان در که است امید پردازیم می

 . نمایید سازی پیاده را خود های ایده راحتی

 منابع از و شده صرف زیادی زمان دوره این مباحث گردآوری برای که شویم یادآور است ذکر به لازم پایان در•
 و کاربردی های دوره با و بتوانیم گذشته همچون عزیزان شما حمایت با است امید است شده استفاده مناسبی و معتبر

 ...باشیم عزیزان شما خدمت در دیگری مناسب
 

  خوبان شما همه برای موفقیت آرزوی با•
 4 تیم سون لرن
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 (shortcuts)کلید های میانبر
 

با توجه به تنوع زیاد ابزار ها و منوها در نرم افزار فتوشاپ این نرم افزار همانند سایر نرم افزار ها برای بالا بردن سرعت •
عمل و دسترسی به ابزارها و موارد مورد نیاز در هنگام کار روی پروژه ها شورتکات های متنوعی رو برای ابزارها بطور پیش 

فرض در نظر گرفته که قابلیت سفارشی سازی و افزایش آنها نیز وجود دارد که در طول دوره به آنها اشاره خواهیم کرد و 
همچنین در ویدئو های این دوره قابلیتی رو برای شما دانشجویان محترم ایجاد کرده ایم که در هنگام استفاده از شورتکات  

ها در نرم افزار همزمان شورتکات مورد نظر و کلید های ترکیبی استفاده شده برای فعال سازی ابزار یا بخشی خاص در نرم 
 استفاده می کنیم  PCافزار برای شما به نمایش درآید، از این رو  ما در این دوره از 

استفاده می کنند متفاوت خواهد بود که در جدول   MACبرای دوستانی که از  …,ctrl,alt,enterکلید های میانبر اصلی مانند •
   زیر معادل آنها را برای راحتی این دسته از دوستان قرار داده ایم

 
 

PC MAC 

Ctrl Command(cmd) 

Alt Option(opt) 

Backspace Delete 

Shift Shift 

Enter Return 

5 



 سر فصل های دوره آموزشی تکنیک های فتوشاپ به تفکیک موضوع 

 فصل اول•
 بررسی مباحث مرتبط با متون و معرفی تکنیک های مرتبط به آن •

 
 متن یک ایجاد از شد خواهید آشنا گرافیکی متون ایجاد برای ها تکنیک مختلف انواع با شما فصل این در     

 دراین.کنیم می مشاهده... و مجلات در زیاد دفعات به که ویژه گرافیکی های جلوه به آن تبدیل تا ساده
 و جالب گرافیکی های جلوه تا بود خواهیم قادر ساده ترفند و تکنیک چندین با که دید خواهید فصل

 انتهایی و ایی ابتد تصاویر فصل این با شما بیشتر آشنایی برای ادامه در که کنیم ایجاد را ای پیچیده
 . ایم داده قرار را فصل این های پروژه
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 سر فصل های دوره آموزشی تکنیک های فتوشاپ به تفکیک موضوع 

 فصل دوم•
 بررسی مباحث مرتبط با جلوه های گرافیکی رو تصاویر و عکس ها•

 
در این فصل شما با انواع مختلف تکنیک ها برای ایجاد جلوه های گرافیکی روی تصاویر و عکس ها  •

ها   Maskنحوه استفاده از فیلتر های متعدد و گوناگون همگون سازی تصاویر ایجاد . آشنا خواهید شد 
مباحث مربوط با افکت ها و بلندینگ ها آشنا خواید شد که در ادامه به جزئیات بیشتری خواهیم پرداخت 
و در بخش معرفی پروژه های هر جلسه با جزئیات بیشتری از مباحثی که در هر جلسه کار خواهیم کرد  

 ...در ادامه هم می توانید تصاویر ابتدایی و پایانی پروژه های این فصل را مشاهده نمایید.آشنا خواهید شد
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 سر فصل های دوره آموزشی تکنیک های فتوشاپ به تفکیک موضوع 

 فصل سوم•
 بررسی مباحث مرتبط با عکاسی و تکنیک های مختص آن•

 
در این فصل شما با انواع مختلف تکنیک ها برای ویرایش تصاویر خود اعم از رتوش حدف عناصر مورد •

بازسازی و افزودن رنگ به کار با نور روی تصاویر   HDR   نظر از تصاویر ادغام تصاویر ایجاد تصاویر
فصل می تواند کمک  این.مسائل کاربردی دیگری آشنا خواهید شد  تصاویر قدیمی و آسیب دیده و

زیادی به علاقه مندان این مبحث نماید و در ادامه هم با تصاویر و جزئیات بیشتری از این فصل آشنا  
 ...خواهید شد
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 سر فصل های دوره آموزشی تکنیک های فتوشاپ به تفکیک موضوع 

 فصل چهارم•
 (بعدی3) 3Dمبحث  با بررسی مباحث مرتبط•

 
این .و کار روی عناصر سه بعدی آشنا خواهید شد  در این فصل شما با چندین تکنیک مختلف برای ایجاد•

    وارد نرم افزار فتوشاپ شد و تا به امروز و در این دوره که ما از ورژن   CS4مبحث از ورژن 
CC(Creative Cloud)  استفاده خواهیم تغییرات چشمگیر و حرفه ای در این نرم افزار صورت گرفته

نرم افزار های تخصصی در این زمینه   Adobeاست تا جایی که ممکن است در آینده نزدیک شرکت 
البته چون این مبحث خود نیاز به یه دوره جامع و .را به چالش بکشد... و  Mayaو یا   3D MAXهمچون 

جداگانه دارد لذا ما زیاد وارد جرئیات این مبحث نخواهیم شد اما شما را با چندین تکنیک و ترفند در این 
زمینه آشنا خواهیم کرد تا علاقه مندان به این مبحث آشنایی مناسب و معقولی با ابزارها و نحوه کار با آن 

 را فرابگیرند
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 سر فصل های دوره آموزشی تکنیک های فتوشاپ به تفکیک موضوع 

 پنجمفصل •
 (طراحی قالب سایت و بنرهای تبلیغاتی متحرک)کاربردهای فتوشاپ در طراحی وب •

 
به تشریح کاربردهای فتوشاپ در طراحی قالب صفحات وب و بنرهای متحرک و تبلیغاتی   در این فصل•

برای اینکه به صورت کاملا عملی و کاربردی این بحث را . موجود در سایت های مختلف خواهیم پرداخت
پروژه عملی شما را با  3فراگیرید، پس از تشریح و تدریس مفاهیم اصولی و پایه ای مورد نیاز، در قالب 

پروژه ای که در  3. نحوه ساخت بنرهای متحرک تبلیغاتی و ایجاد قالب صفحات وب آشنا خواهیم کرد
 :با هم طراحی و ایجاد خواهیم نمود عبارتند از  5فصل 

 
 تبلیغاتیطراحی بنر متحرک 1.
 طراحی قالب و رابط کاربری وب سایت 2.
 طراحی قالب برای بخش مدیریت وب سایت3.
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 سر فصل های کلی دوره آموزشی تکنیک های فتوشاپ

 Layerمعرفی و بررسی پنل •
 کاربرد لایه ها •
 نحوه ایجاد و حذف یک لایه•
 نحوه ایجاد و حذف پوشه•
 وکاربرد آن   Layer Maskنحوه ایجاد و حذف •
 نحوه ایجاد و حذف افکت رو یک لایه•
 Bevel & Embossبررسی افکت •
  Storkeبررسی افکت •
  Inner shadowبررسی افکت •
  Inner Glowبررسی افکت •
  Color Overlayبررسی افکت •
  Gradient Overlayبررسی افکت •
  Gradient Overlayبررسی افکت •
  Pattern Overlayبررسی افکت •
  Outer Glowبررسی افکت •
 Drop Shadowبررسی افکت •
 
 

 1: صفحه 
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 سر فصل های کلی دوره آموزشی تکنیک های فتوشاپ

   Blend Modeمعرفی و بررسی منوی •
 Multiplyبررسی حالت •
 Lightenبررسی حالت •
 Screenبررسی حالت •
 Color Dodgeبررسی حالت •
 Overlayبررسی حالت •
 Soft Lightبررسی حالت •
 Linear Lightبررسی حالت •
 Hueبررسی حالت •
 Saturationبررسی حالت •
 Colorبررسی حالت •
 Luminosityبررسی حالت •
 Vivid Lightبررسی حالت •

 
 

 
 
 
 

 2: صفحه 
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 سر فصل های کلی دوره آموزشی تکنیک های فتوشاپ

oمعرفی و بررسی جعبه ابزار 
 

• Rectangular Selection Tool 
• Elliptical Tool 
• Single row Tool 
• Single Column Tool 
• Lasso Tool 
• Polygonal Tool 
• Magnetic Tool 
• Quick Selection Tool 
• Magic wand Tool 
• Lasso Tool 
• Polygonal Tool 
• Magnetic Tool 
• Crop Tool 

 
 

 
 
 
 
 

 3-1: صفحه 
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 سر فصل های کلی دوره آموزشی تکنیک های فتوشاپ

 معرفی و بررسی جعبه ابزار•
 

• Eyedroper Tool 
• Elliptical Tool 
• Healing Brush Tool 
• Spot Healing Brush Tool 
• Patch Tool 
• Red Eye Tool 
• Brush Tool 
• Pencil Tool 
• Eraser Tool 
• Background Eraser Tool 
• Gradient Tool 
• Dodge Tool 
• Burn Tool 

 
 

 
 
 
 
 

 3-2: صفحه 
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 سر فصل های کلی دوره آموزشی تکنیک های فتوشاپ

 معرفی و بررسی جعبه ابزار•
 

• pen Tool 
• Type Tool 
• Path Tool 
• Rectangular  Shape Tool 
• Rounded Rectangular  Shape Tool 
• Ellipse Shape Tool 
• Poygon Shape Tool 
• Line Shape Tool 
• Custom Shape Tool 
• Hand Tool 
• Zoom Tool 
• Set Color Tool 

 
 

 
 
 
 
 

 3-3: صفحه 
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 سر فصل های کلی دوره آموزشی تکنیک های فتوشاپ

 معرفی و استفاده از فیلتر ها•
 
 )  (Render-> Cloudsفیلتر •
 ( Render-> DifferenceClouds)…فیلتر    •
  (Stylize-> wind)فیلتر •
   (Sketch-> Chalk & Chaircoal)  فیلتر•
   (Distort-> Displace)فیلتر •
  (Distort-> Ripple)    فیلتر•
 (Sketch-> bas Relief)    فیلتر•
   (Blur-> Motion Blur) فیلتر•
   (Sketch-> Chalk & Chaircoal)  فیلتر•
 (Pixelate-> Color Halftone)  فیلتر•
   (Distort-> Twirl)  فیلتر•
 (Sharpen-> Smart Sharpen)  فیلتر•
 (Sharpen-> Unsharp Mask)  فیلتر•
   (Other-> High Pass)  فیلتر•
•  

 
 

 
 
 
 
 

 4-1: صفحه 
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 سر فصل های کلی دوره آموزشی تکنیک های فتوشاپ

 معرفی و استفاده از فیلتر ها•

 
      (Blur-> Gaussian) فیلتر•
   (Blur -> Smart Blur)  فیلتر•
   (Sketch -> Note Paper)  فیلتر•
   (Other -> Offset)   فیلتر•
  (Sharpen-> Smart Sharpen) فیلتر•
    (Noise-> Reduse Noise)فیلتر•
 (Noise-> Add Noise)فیلتر•
   (Noise-> Median)  فیلتر•
 (Blur-> Radial Blure)فیلتر  •
   (Blur-> Lens Blure)فیلتر •
    ( Pixelate-> Color Halftone)فیلتر•
 (Distort->Glass)…  فیلتر•

 
 

 
 

 
 
 
 
 

 4-2: صفحه 
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 مروری بر بخشی از جزئیات دوره آموزشی تکنیک های فتوشاپ

 :می گیریم دوره فرا این در آنچه 
 
آشنایی و نحوه استفاده از جعبه ابزار فتوشاپ 
آشنایی با منو ها در فتوشاپ 
آشنایی با کلید های میان بر و ترکیبی در فتوشاپ 
فراگیری استفاده از پر کاربردترین فیلتر های فتوشاپ 
 لایه ها و افکت هاکار با 
نورپردازی در فتوشاپ 
ایجاد افکت های متنوع بروی متون 
پردازش و رتوش تصاویر ویژه عکاسان 
خلق افکت های متنوع روی تصاویر 
 بعدی  3ایجاد عناصر 
 خاصتصاویر ادغام تصاویر و خلق 

5: صفحه   
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 مروری بر بخشی از جزئیات دوره آموزشی تکنیک های فتوشاپ

 فتوشاپایجاد و نوشتن متن در نحوه 
 نحوه ایجادsmart object   آنو فواید 
 معرفی ابزار چرخش(rotate) 
 ابزارکار با و معرفیCanvas Size  
 آمادهو نحوه استفاده از اکشن های معرفی 
 هانحوه کپی گرفتن از لایه 
 بررسی منویGrayscale   آنو کاربرد 
 ایجاد پس زمینه هایflat  برای همگون سازی متون با پس زمینه ها و نحوه ذخیره آنها با فرمت مناسب 
 ایجادmap  از تصاویر  و استفاده مجدد از آنها 
 معرفی و کار با ابزارBurnTool 
 معرفی منویBlende Mode->Multiply 
 بررسی و نحوه استفاده از پنلLayer Camp   برای پیمایش آسان بین لایه ها و نمایش صحیح هر

 تصویر به همرا افکت مربوط به خودش

 

6: صفحه   
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 مروری بر بخشی از جزئیات دوره آموزشی تکنیک های فتوشاپ

 
 ایجاد میانبر ها نحوه(Shortcuts ) سفارشیهای 
نحوه کپی کردن افکتهای یک لایه و اعمال آن به سایر  لایه ها و تصاویر 
 بررسی پنجره Color Overlay  و استفاد از تنظیمات آن برای تکنیک 
 بررسی پنجره Drop Shadow 
 بررسی پنجره Satin 
 معرفی با ابزارBrush 
  بررسی پنجرهInner Glow 
 بررسی پنجره Outer Glow 
 بررسی پنلChannels   و کار با لایه هایRGB 
 استفاده ازBlend mode->screen  و توضیح در مورد آن 
جدا سازی تصاویر با جزئیات کامل از پس زمینه های ساده و یک دست 
 نحوه استفاده ازBrushTool   برای ایجاد سایه وHightlight  روی تصاویر 
 آشنایی با ابزارlasso Tool برای انتخاب و جدا سازی  بخشی از یک  تصویر 

 

 
 
 
 

7: صفحه   
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 مروری بر بخشی از جزئیات دوره آموزشی تکنیک های فتوشاپ

نحوه ایجاد لایه های گروهی 
انتقال طرح ها بین دو محیط و پنجره در فتوشاپ 
 ایجادLayer mask  و کاربرد آن 
 آشنایی با ابزارGradient Tool  و کاربرد آن 
 آشنایی با ابزارSmudge Tool  و کاربرد آن 
 نحوه انتخاب رنگ قسمتی از تصویر توسط ابزارEye Dropper (قطره چکان) 
 کار با پنلColor 
نحوه کپی کردن  لایه های گروهی 
 استفاده ازBlend mode->Hardlight  و توضیح در مورد آن 
 استفاده ازBlend mode->Softlight  و توضیح در مورد آن 
 آشنایی با ابزار Rectangular Marquee Toolو کاربرد آن 
 استفاده از ابزارLasso Tool  Polygonal برای برش 
 معرفی استفاده از ابزارModify->expand 
 معرفی و استفاده از ابزارWarp,Distort  برای تغییر حالت و زاویه دادن به متون 
  ایجاد متن توسط ابزارBrush 
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 مروری بر بخشی از جزئیات دوره آموزشی تکنیک های فتوشاپ

 استفاده ازLayer Style  برای ایجاد افکت های مختلف روی متن 
 بررسی نحوهmap  کردن دو تصویر با یکدیگر 
 استفاده ازBlend mode->Hard mix  و توضیح در مورد آن 
 کار با سایه ها در پنجرهBevel  and Emboss 
 نحوه استفاده ازBrushTool   برای ایجاد سایه وHightlight  روی تصاویر 
بررسی نحوه ادغام سایه روشن ها و سایه های تصاویر 
 تبدیل قسمت های انتخاب شده تصاویر بهLayer mask  
Mask   کردن دو تصویر توسط ابزارMagic Wand Tool     وLayer Mask 
 استفاده از ترفندTransform hidder  برای مخفی کردن رنگ های اضافه 
 نحوه ایجاد لایه های گروهی(Group Layer) 
 معرفی ابزارGradient  ایجادGradient  سفارشی 
 بررسی منویKnock Out   
 بررسی منویGrayscale  و کاربرد آن 
 بررسی ابزارColor Range 
 معرفی ابزارMagic Wand Tool   برای انتخاب و جدا سازی تصاویر دارای پس زمینه یکدست 
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 مروری بر بخشی از جزئیات دوره آموزشی تکنیک های فتوشاپ

 بررسی منویGrayscale  و کاربرد آن 
 معرفی و استفاده از ابزارEraser Tool  (پاک کن) 
 آموزش ایجادBrush  های دلخواه و بررسی تنظیمات آن 
 معرفی و کار با ابزارLiquify 
 معرفی ابزارModify 
 جستجو و تهیه ابزار های مورد نیاز در اینتزنت: 
 پترن ها(Patterns) 
 تکسچر ها(Texyures) 
 براش ها(Brushes) 
 گرادینت ها(gradients) 
 پلاگین ها(Plugins) 
 اکشن ها(Actions) 
 فون ها(Fons) 
اکشن چیست؟ 
نحوه استفاده از اکشن های آماده 
ایجاد اکشن های سفارشی 
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 مروری بر بخشی از جزئیات دوره آموزشی تکنیک های فتوشاپ

 
 

11: صفحه   

 استفاده از Blend mode->lightenبرای کاهش سایه ها در تصویر 
 استفاده از ابزارExpand  برای ایجاد حاشیه های یکسان در تصاویر انتخاب شده 
 نحوهMask  کردن و پنهان سازی یک تصویر در پشت تصویر دیگر 
  همگون سازی رنگ دو تصویر 
 استفاده از ابزارRefine Mask 
ایجاد عمق در تصاویر قرینه 
استفاده از گرادینت و ایجاد سایه توسط آن 
 معرفی ابزارcalculation   برای تغییر در رنگ و پنجرهAlpha Channel 
 استفاده از Blend mode->linear Dodge    برای تلفیقGradient های سفارشی با فیلتر ها 
 تلفیق کردنCliping mask  در لایه ها 
 نحوه تغییر ابعاد تصاویر توسط ابزارImage Size 
 نحوهRastrize  کردن متون و تصاویر و فواید آن 
  3معرفی  منویD->repousse  بعدی3بعدی به متن  2نحوه تبدیل متن 
 3معرفی جعبه  ابزارD   و استفاده از ابزارObject Rotate Tool 
 معرفی ابزارSlide 3D Object  
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 مروری بر بخشی از جزئیات دوره آموزشی تکنیک های فتوشاپ

 نحوه ذخیره اگو(Pattern)   ایجاد شده و چاپ آن در مقیاس بزرگتر 
 بررسی پنلPattern    نحوه درج الگو(Pattern) ایجاد شده در سند جدید 
 نحوه تغییر مقیاس سند چاپی توسط پنلCanvas 
 حذف پس زمینه تصاویر توسط پنلLevels 
 معرفی ابزارPenTool  و نحوه استفاده و ایجاد مسیر(path) دلخواه اطراف تصویر مورد نظر 
 معرفی ابزارDirect Selection Tool و نحوه و موارد استفاده از آن 
 استفاده از  فیلتر(Other->High Pass )و نحوه ست کردن تنظیمات آن 
 معرفی ابزارLevel  
 بررسی و معرفی ابزارGuides  برای رسم خطوط راهنما 
 بررسی و استفاده از ابزارHealing Brush Tool 
 بررسی و استفاده از ابزارHide Healing Brush Tool  
 نحوه ایجادHighLight  برای تصویر مورد نظر 
 نحوه ایجادDisplace Map 
 آموزش ایجادBrush  های دلخواه و بررسی تنظیمات آن 
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 مروری بر بخشی از جزئیات دوره آموزشی تکنیک های فتوشاپ

 کار با پنلChannel 
 بررسی پنلBlack and White  برای تبدیل تصاویر رنگی به سیاه و سفید 
معرفی واستفاده از ابزارTool  Dodge برای ایجاد سایه های روشن 
معرفی واستفاده از ابزارTool  burn برای ایجاد سایه های تیره و انعکاس نور 
 استفاده از Blend mode->color   و توضیح دو مورد کاربر آن 
 بررسی روشHand masking  
 بررسی منویApplay Image 
 معرفی پالت رنگHue/saturation 
 معرفی ابزارColor Range   و ایجادMask Color 
 معرفی و استفاده از ابزارRed Eye Tool 
 معرفی ابزارcalculations   برای پردازش ابزارColor Channel 
 معرفی و کار با ابزارChannel Mixer 
 معرفی و استفاده از ابزارFade Gaussion Blure 
  استفاده از ابزارHide Healing Brush Tool  
 بررسی پنلClone Source 
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 مروری بر بخشی از جزئیات دوره آموزشی تکنیک های فتوشاپ

 معرفی ابزارColor Range برای شبیه سازی قسمت های حذف شده 
 از فیلتر معرفی(Noise->Median) 
 بررسی منویModify->Contrast 
 معرفیCopy Merged 
 بررسی منویModify->Contrast 
 معرفی و استفاده از ابزارColor-Range->skinTones 
 معرفی ابزارSponge Rainbow 
 معرفی و استفاده از ابزارQuick Selection Tool 
 معرفی و استفاده از ابزارModify->Feather 
 معرفی و استفاده از ابزارVibrance 
 بررسی منویLab Color  
 بررسی خاصیتLab Mode 
 بررسی منویShadows/Highlights 
 استفاده ازBlend mode->luminosity 
  معرفی و استفاده ازCamera Raw 
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 مروری بر بخشی از جزئیات دوره آموزشی تکنیک های فتوشاپ

 معرفی دستورGradient Map 
 از ابزار معرفیReflected Gradient 
 ابزار معرفیRasterize Layer   برای تغییر لایه ها از حالتSmart Object   به حالتStatic Pixel 
 ایجاد نحوهVibrance Layer   آنوکاربرد 
  نحوه ایجاد گرادینت سفارشی 
 نحوه ایجاد وانتخاب نواحی ثابت توسط ابزارRecatangular 
 پنل کار با معرفی وParagraph   متونبرای تنظیمات 
 معرفی  و استفاده از ابزارColor Sampler Tool 
نحوه جداسازی بک گراند از تصویر مورد نظر 
 استفاده از ابزارClipping mask 
 معرفی و استفاده از ابزارSpot Healing Brush Tool 
 معرفی و استفاده از ابزارPatch Tool 
 معرفی و استفاده از ابزارColor Replacment Tool    
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 مروری بر بخشی از جزئیات دوره آموزشی تکنیک های فتوشاپ

 معرفی و استفاده از دستورFill->content-Aware 
 قرار دادن دوSmart Object  درون یکدیگر 
 معرفی ابزارPolygonal Lasso Tool    
 معرفی و استفاده از ابزارRed Eye Tool 
 معرفی ابزارDrag 3D Object  
  معرفی پنلDrag 3D Scene   واستفاده از ابزار های موجود در آن 
 نحوهRender   کردن و استفاده از ابزارRay Traced Draft  لبه ها ,برای از بین بردن شکستگی خطوط

 و خمیدگی ها در  تصاویر سه بعدی ایجاد شده
 معرفی  منوی->Selected Path 3D->repousse  
 بعدی3نحوه افزودن و لود کردن رنگ های بیشتر برای عناصر 
  نحوه تغییر رنگ عناصر و سایه ها توسط ابزارهای 

• Rectangle Front infection Material 
• Rectangle Front Bevel Material 
• Rectangle Extrusion Material 
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 مروری بر بخشی از جزئیات دوره آموزشی تکنیک های فتوشاپ

 3بعدی نظیر 3نحوه غیر فعال سازی مخفی شدن لایه ها در هنگام کار با ابزارهایD Object tPan 

Tool 
  بررسی منویMarge 3D Layers   3برای ادغام لایه ها در مبحثD 
 3بررسی پنلD(Mesh)   3و استفاده از ابزارD Mesh Slide Tool  برای حرکت اشیاء درون یکدیگر 
 بررسی ابزارInfinite Lights 
 نحوه استفاده از ابزارLight Rotate Tool 
 3بررسی پنلD(LIGHTS) 
 منوی کار با  معرفی وLight Type 
 نحوه حرکت دادن نور در عمق و جهات مختلف    (orientation) 
 نحوهMask   کردن تصویر باPath  ایجاد شده 
نحوه تهیه تصاویر  برای تبدیل به تصاویر سه بعدی 
 کار روی تصاویر در نرم افزارAdobe Brige 
 3 استفاده از ابزارD Objec tPan Tool  در صفحه  بعدی3حرکت دادن اشیاء 
 استفاده از ابزارBrush  برای ایجاد بعد در تصاویر 
وارد کردن تصاویر در فتوشاپ و پردازش آنها 

 
و موارد بسیار مفید و کاربردی دیگر 
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 فصل اول
 

 

 

 

 

 

 
 

آنبررسی مباحث مرتبط با متون و معرفی تکنیک های مرتبط به   
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  ice typeبررسی ترفند : جلسه اول 

باز کردن تصاویر مورد نظر در فتوشاپ 
ایجاد لایه ها در فتوشاپ 
نحوه ایجاد و نوشتن متن در فتوشاپ 
 نحوه ایجادsmart object  و فواید آن 
 معرفی ابزار چرخش(rotate) 
 معرفی و کار با فیلتر(Stylize->wind) 
معرفی و کار با افکتBevel  and Emboss  
معرفی و کار با افکتBevel and Emboss->texture  
معرفی و کار با ابزارCanvas Size  
معرفی و نحوه استفاده از اکشن های آماده 
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 درج متون روی تصاویر و پس زمینه های متفاوت بصورت حک شده: جلسه دوم

نحوه کپی گرفتن از لایه ها 
 ایجاد پس زمینه هایflat   برای همگون سازی متون با پس زمینه ها و نحوه ذخیره آنها با فرمت

 مناسب
 معرفی و کار با فیلتر(Distort->Displace Map) 
 معرفی و کار با فیلتر(Blur->Gaussian) 
 ایجادmap  از تصاویر  و استفاده مجدد از آنها 
 معرفی و کار با ابزارBurnTool 
 معرفی منویBlende Mode->Multiply 
معرفی و کار با افکتBevel and Emboss  
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ایجاد کتابخانه از ترفند جلسه قبل برای استفاده راحت تر  در سایر تکسچر ها و تصاویر  : جلسه سوم 
 پس زمینه مورد 

تصاویر بروی شده حکاکی بصورت متون درج برای کتابخانه ایجاد مورد در جلسه این در  
  تکراری عملیات انجام از کارامد ترفند یک با چطور که میگیریم فرا و میکنیم صحبت متفاوت

 هست نظرمون مد که تکسچری و تصویر هر بروی براحتی رو قبل جلسه ترفند و کرده جلوگیری
 .کنیم سازی پیاده و اعمال

 
تصاویر و ها لایه  سایر به آن اعمال و لایه یک افکتهای کردن کپی نحوه 
پنل از استفاده نحوه و بررسی Layer Camp  صحیح نمایش و ها لایه بین آسان پیمایش برای 
 خودش به مربوط افکت همرا به تصویر هر
 
ها میانبر ایجاد نحوه (Shortcode) سفارشی های 

 
 
 
 

 برای مشاهده تصاویر این جلسه به صفحه بعد بروید
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 ... Rendering type in goldبررسی تکنیک  : جلسه چهارم 

   تبدیل متون ساده به متون براق و طلایی این بار بدون استفاده از فیلتر ها و تنها با استفاده از
 افکت ها

 معرفی و استفاده از فیلترRender->Clouds  
 معرفی و استفاده از فیلترRender->DifferenceClouds  
 معرفی و استفاده از فیلترDistort->Glass 
 کار با پنجرهLayer Style 
 بررسی پنجره Color Overlay 
 بررسی پنجره Drop Shadow 
 بررسی پنجره Satin 
 معرفی و استفاده از ابزارRectangular Marquee Tool  
 آشنایی با ابزارBrush و ایجاد انعکاس نور توسط آن 
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   Blaze type effectبررسی تکنیک  : جلسه پنجم 

  بررسی پنجرهInner Glow 
 بررسی پنجره Outer Glow 
 معرفی و کار با فیلتر(Distort->Ripple) 
 معرفی و کار با فیلتر(Sketch->bas Relief) 
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  Fire Blaze  type effectبررسی تکنیک  : جلسه ششم 

 بررسی پنلChannels   و کار با لایه هایRGB 
 استفاده ازBlend mode->screen  و توضیح در مورد آن 
جدا سازی تصاویر با جزئیات کامل از پس زمینه های ساده و یک دست 
 آشنایی با ابزارlasso Tool   برای انتخاب و جدا سازی  بخشی از یک  تصویر 
نحوه ایجاد لایه های گروهی 
انتقال طرح ها بین دو محیط و پنجره در فتوشاپ 
 ایجادLayer mask  و کاربرد آن 
 آشنایی با ابزارGradient Tool  و کاربرد آن 
 آشنایی با ابزارSmudge Tool  و کاربرد آن 
 نحوه انتخاب رنگ قسمتی از تصویر توسط ابزارEye Dropper (قطره چکان) 
 کار با پنلColor 
نحوه کپی کردن  لایه های گروهی 
 استفاده ازBlend mode->Hardlight  و توضیح در مورد آن 
 استفاده ازBlend mode->Softlight  و توضیح در مورد آن 
 آشنایی با ابزار Rectangular Marquee Toolو کاربرد آن 

 
 نهایی پروژه این جلسه به صفحه بعد بروید برای مشاهده تصویر
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  Fire Blaze  type effectتصویر نهایی تکنیک  : جلسه ششم 
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 Creating leafy letters -   بررسی تکنیک: جلسه هفتم

 بررسی پنلCharacter و تنظیمات مربوط به متن 
 ایجادLayer Msak  از تصاویر دلخواه و قرار دادن آن روی متنون 
 معرفی و استفاده از ابزارRefine Mask 
حک کردن متنون در تصویر پس زمینه و اعمال افکت دلخواه به آن 
 نحوه محو کردن متن توسط ابزارFill 
  بررسی پنجرهInner Shadow 
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 Creating topiary type -   بررسی تکنیک: جلسه هشتم

 استفاده متفاوت از ابزارRefine Edge 
 استفاده متفاوت از ابزارLayer Mask 
  معرفی و بررسی ابزارFill and adjustment ->Levels 
همگون سازی متن با تصویر پس زمینه مورد نظر 
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   Creating type in grass       - بررسی تکنیک : جلسه نهم

 بررسی کامل ابزارRectangular Marquee Tool و تنظیمات آن 
 معرفی ابزارModify  و زیر منوی های آن برای گرد گردن گوشه های تصاویر 
 معرفی و کار با فیلتر(Noise->Median) 
 بررسی تکنیک ایجاد Layer Mask های مجزا و اعمالRefine mask  به هر یک از آنها 
بررسی تکنیک عمق دادن و هم پوشانی تصاویر و ایجاد خطای دید 
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 Rendering type in smoke -بررسی تکنیک : جلسه دهم

بررسی تکنیک لایه سیاه 
 معرفی و استفاده از فیلترDistort->Wave 
 معرفی و استفاده از فیلترBlur->Motion Blure 
 استفاده ازBlend Mode->Color Dodge 
 استفاده از فیلتر(Blur->Gaussian Blur) 
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  ترفند ایجاد نور و سایه – Rendering type in brushed metal  -بررسی تکنیک : جلسه یازدهم
 تنها توسط ابزار گرادینت  

 ایجاد اسناد در حالتColor Mode->Grayscale 
 معرفی  و استفاده از  فیلتر(Noise->Add noise) 
 معرفی  و استفاده از  فیلتر(Stylize->Emboss) 
 نحوه ایجادpattern  دلخواه توسط  فیلترها 
 بررسی پنجره Gradient Overlay 
 بررسی پنجره Stroke 
نحوه ایجاد گرادینت دلخواه 
 معرفی و استفاده از ابزارShape Tool 
  نحوه ایجاد نور و سایه روشن های دلخواه توسط فیلترGaussian Blur   
 بررسی کامل تغییر رنگ طرح ایجاد شده توسطGradient  های دلخواه 
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 (ایجاد لوگو)  Surfer Style type   -   بررسی تکنیک: جلسه دوازدهم

 معرفی و استفاده از ابزارRasterize Layer  
 معرفی استفاده از ابزارModify->expand 
 معرفی و استفاده از فیلترPixelate->Color Halftone  
 معرفی و استفاده از ابزارWarp,Distort  برای تغییر حالت و زاویه دادن به متون 
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 Hand-carving letters into woodبررسی تکنیک   : جلسه سیزدهم
 
 معرفی و استفاده از ابزارMagic Wand Tool 
   نحوه مسک کردن و مخفی سازی بخش هایی از یک تصویر توسطLayer Mask 
 ایجاد متن توسط ابزارBrush 
 استفاده ازLayer Style  برای ایجاد افکت های مختلف روی متن 
  بررسی و نحوه ایجاد لایه هایSolid Color 
 بررسی و استفاده ازBlend Mode->Dissolve 
 استفاده از فیلترBlur->Motion Blur 
 معرفی و استفاده از فیلترSharpen->Smart Sharpen 
 (ایجاد حالت پوسیدگی در متن)نحوه همگون سازی متن با تصویر 
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 Puppet Warp بررسی تکنیک   : جلسه چهاردهم

ایجاد متن این بار توسط تصاویر دلخواه 
 معرفی و استفاده از ابزارMatting 
 معرفی و استفاده ترکیبی از ابزارDesaturare  وOverlay  برای پر رنگ کردن عناصر 
 معرفی و استفاده از ابزار جدید فتوشاپ با عنوانpuppet warp   برای ایجاد انحنا در

 تصاویر
  دلخواه و تبدیل آنها به کارکتر های دارای انحنا 
  نحوه ایجاد عمق و سایه توسط استفاده ترکیبی از ابزارFill,Burn Tool  وBlend mode-

>Hard light 
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 type reflectionبررسی تکنیک  : جلسه پانزدهم

نحوه ایجاد قرینه سازی 
نحوه ارسال تصاویر به سند جدید 
 بررسی ابزارGray scale 
 بررسی ابزارAuto contrast 
 ایجاد موج روی کارکتر ها و تصاویر با استفاده از فیلترDistort->Displace Map  
 معرفی تکنیک کاهش پراکندگی اجزا تصاویر توسط فیلترBlur-> Gaussian Blur 
 معرفی و استفاده ازClipping Mask  
معرفی تکنیک همسان سازی لبه ها در قسمت ابتدایی انعکاس تصاویر 
 بررسی پنل تنظیماتLayer Mask   ها 
نحوه ایجاد انعکاس نور در اجسام 
 نحوه یکسان سازی اندازه تصاویر بدون استفاده از ابزارTransform 
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 Text in pathبررسی تکنیک   : جلسه شانزدهم

 نحوه تبدل تصاویر بهPath 
 استخراج تصاویر ازPath  
 قرار دادن متون درpath   ایجاد شده 
ترفند کاربردی برای از بین بردن فاصله بین کارکتر ها 
 نحوه درج متون درPath  های دلخواه 
 نحوه درج متون بر رویPath  های دلخواه 
 معرفی و استفاده از ابزارPen Tool  برای ایجادPath های دلخواه 
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 Typography Text Posterبررسی تکنیک  : جلسه هفدهم

 اعمالPattern  های دلخواه به پس زمینه اسناد 
 ایجادHigh Ligh   توسطLayer Mask  ها روی متون 
 کار باLayer Mask  ها در لایه های گروهی 
 اعمالLayer Style  روی لایه های گروهی 
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 splash Masking Textبررسی تکنیک : جلسه هجدهم 

 استفاده ازClipping Layer Mask بصورت گروهی روی چندین لایه 
 ترکیب و یکی کردن چندین لایه  توسط ابزارMerge Layer   و بررسی حالت های مختلف

 آن 
ادغام متن با تصاویر 
 معرفی و استفاده از ابزارEraser Tool  برای پاک و محو کردن قسمتی از تصویر 
 معرفی و استفاده از براشProcemo_Splatter 
 نحوه بارگذاریBrush  های خارجی در نرم افزار 
 ایجاد جلوه های ویژه توسط  براشProcemo_Splatter   
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 Glowing galaxy text بررسی تکنیک : جلسه نوزدهم 

پرکردن رنگ درون متون توسط ابزار گرادینت 
 استفاده ازBlande Mode->Color Dodge  برای یکسان سازی رنگ های متفاوت در

   Render->cloudsهنگام استفاده از فیلتر 
پراکنده سازی رنگ های درون متنون توسط فیلترBlur->Gaussian Blure 
 معرفی و استفاده از براشRabies Star  
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  heavy metal type بررسی تکنیک : جلسه بیستم 

 استفاده ازShape Tool  بار برای ایجاد پترهای تکرار شونده  این(Repeating Patterns) 
 بررسیVector Mask ها 
 نحوه جداسازی قسمت هایی از رنگ طرح از کل طرح توسطChannel RGB  
  بررسی تکنیک ایجاد لبه و تورفتگی با استفاده از انتخاب بخش های مورد نیاز توسط

Channel RGB  
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  broken glassy text بررسی تکنیک : جلسه بیست و یکم 

بررسی و نحوه اعمالTexture  های گوناگون به متن 
 استفاده از ابزارBlend Mode->multiply   برای جایگزینیTexture  و تصویر مورد نظر با

 رنگ متون
اعمال افکت از پنجره   Layer Style روی چندین ناحیه انتخاب شده بصورت ترکیبی 
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 تهیه ابزارها و طرح های مورد نیاز: و دوم  جلسه بیست

 جستجو و تهیه ابزار های مورد نیاز در اینتزنت: 
 پترن ها(Patterns) 
 تکسچر ها(Textures) 
 براش ها(Brushes) 
 گرادینت ها(gradients) 
 پلاگین ها(Plugins) 
 اکشن ها(Actions) 
 فون ها(Fons) 

 
اکشن چیست؟ 
نحوه استفاده از اکشن های آماده 
ایجاد اکشن های سفارشی 

 
توضیحات تکمیلی و پیشنهادات در مورد فصل اول 
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 فصل دوم
 

 

 

 

 

 

 
 

 بررسی مباحث مرتبط با جلوه های گرافیکی رو تصاویر و عکس ها
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     Blending textures onto a faceبررسی تکنیک    :جلسه اول 

 بررسی نحوهmap  کردن دو تصویر با یکدیگر 
 استفاده ازBlend mode->Hard mix  و توضیح در مورد آن 
 کار با سایه ها در پنجرهBevel and Emboss 
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 (سبک نقاشی های باستانی روی دیوارهای غارها) cave paintingبررسی تکنیک    :جلسه دوم 

 معرفی و کار با فیلتر(Sketch->Chalk & Chaircoal) 
 بررسی منویGrayscale  و کاربرد آن 
 معرفی و کار با فیلترRender->Clouds)) 
 نحوه استفاده ازBrushTool   برای ایجاد سایه وHightlight  روی تصاویر 
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 بخش اول -در تصاویر  maskingو  highlights and shadowsبررسی تکنیک    :جلسه سوم 

بررسی نحوه ادغام سایه روشن ها و سایه های تصاویر 
 تبدیل قسمت های انتخاب شده تصاویر بهLayer mask  
 بررسی ابزارColor Range 
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 بخش دوم -در تصاویر  maskingو highlights and shadowsبررسی تکنیک    :جلسه چهارم

 معرفی ابزارMagic Wand Tool     برای انتخاب و جدا سازی تصاویر دارای پس زمینه
 یکدست

Mask   کردن دو تصویر توسط ابزارMagic Wand Tool     وLayer Mask 
 معرفی و استفاده از ابزارRefine Mask 
 استفاده از ترفندTransform hidder  برای مخفی کردن رنگ های اضافه 
 نحوه ایجاد لایه های گروهی(Group Layer) 
 معرفی ابزارGradient  ایجادGradient  سفارشی 
 بررسی منویKnock Out   
 معرفی و استفاده از ابزارEraser Tool  (پاک کن) 

60 



  reflection in shattered glassبررسی تکنیک    :جلسه پنجم 

 آشنایی با ابزارFreeTransfom  کاهش یا افزایش سایز تصاویر,برای چرخاندن 
 معرفی و کار با فیلتر(Distort->Twirl) 
 معرفی و کار با فیلتر(Sharpen->Smart Sharpen) 
 استفاده ازBlend mode->luminosityو توضیح در مورد آن 
آشنایی با نحوه ایجاد انعکاس نور و نحوه ایجاد آن 
 کار با پالت رنگ و معرفی منویHue/saturation 
 تنظیم شدت نور توسط منویBrightness/Contrast 
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 face in a treeبررسی تکنیک    :ششم   جلسه

 تصویر   2بررسی نحوه تلفیق 
 استفاده از ابزارTransform->warp 
استفاده از Blend mode->linear 
 کار با فیلتر(Sketch->Chalk & Chaircoal) 
 معرفی و کار با فیلتر(Other->High Pass) 
 کار با پالت رنگ و منویHue/saturation 
 استفاده از ابزارBrush   تصویر 2و منطبق کردن 
 استفاده از ابزارInverse  برای معکوس کردن بخش های انتخاب شده 
 استفاده از Blend mode->lighten   برای کاهش سایه ها در تصویر 
 استفاده از ابزارExpand  برای ایجاد حاشیه های یکسان در تصاویر انتخاب شده 
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 path Puzzleبررسی تکنیک    :هفتم   جلسه

 استفاده از ابزارPenTool   برای ایجادPath  بروی قسمت های مورد نظر در تصویر 
 نحوه تبدیلPath  به شی فابل انتخاب 
 نحوه برش زدن اشیائ و قسمت های مورد نظر 
ایحاد بعد با افکت ها 
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 Putting wings on a horseبررسی تکنیک  :جلسه هشتم 

 تصویر 2ادغام بخش های خاص از 
نحوه صحیح استفاده از ابزارBrush   
 حذف پس زمینه تصاویر توسط پنلLevels 
 معرفی ابزارPenTool  و نحوه استفاده و ایجاد مسیر(path) دلخواه اطراف تصویر مورد نظر 
 معرفی ابزارDirect Selection Tool و نحوه و موارد استفاده از آن 
 نحوهMask   کردن تصویر باPath  ایجاد شده 
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بخش  -یا چند تصویر 2ادغام بخش های خاصی از   –  combine pictureبررسی تکنیک : جلسه نهم 
 اول

 بررسی و معرفی ابزارGuides  برای رسم خطوط راهنما 
 بررسی و استفاده از ابزارHealing Brush Tool 
 بررسی و استفاده از ابزارHide Healing Brush Tool 
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بخش  -یا چند تصویر 2ادغام بخش های خاصی از   – combine pictureبررسی تکنیک : جلسه دهم 
 دوم

 بررسی و معرفی ابزارLiquify 
(بزرگنمایی-زاویه دادن-جمع کردن-کشیدن)نحوه تغییر در حالت تصویر... 
 کار با نرم افزارAdobe Brige   برای تبدیل تصاویر به حالت تصاویر گرفته شده با دوربین

 های دیجیتال با کیفیت پایین
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 سوم-یا چند تصویر 2ادغام بخش های خاصی از   – Mapping Faceبررسی تکنیک : جلسه یازدهم 

 بررسی نحوهMap  کردن تصاویر 
نکات کلیدی جامانده از جلسه قبل 
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 hologram effect: بررسی تکنیک : جلسه دوازدهم 

 
 دلخواه برای استفاده در تصویر( الگوی)ایجاد پتنرن 
 نحوه ایجادHighLight  برای تصویر مورد نظر 
 نحوه ایجادDisplace Map 
 نحوه ایجاد نور های براق(Neon Light) 
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 Type Brush Effectsبررسی تکنیک  : جلسه سیزدهم 

 آموزش ایجادBrush  های دلخواه و بررسی تنظیمات آن 
 ایجادLayer Mask  برای بازتاب نور دلخواه روی تصویر 
 ادغام و همگون سازی دو لایه برای ایجاد شکل دلخواه توسطBrush    های ایجاد شده 
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 The headlessبررسی تکنیک  : جلسه چهاردهم 

 استفاده از ابزارcalculation   برای تغییر در رنگ و پنجرهAlpha Channel 
نحوه حذف قسمتی از تصویر و شبیه سازی پشت تصویر حذف شده 
 استفاده ازLayer Mask  
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  into another image merge imagesبررسی تکنیک  : جلسه پانزدهم 

نحوه ارسال تصویر از یک پنچره به پنجره دیگر در فتوشاپ 
 نحوهMask  کردن و پنهان سازی یک تصویر در پشت تصویر دیگر 
  همگون سازی رنگ دو تصویر 
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 Simulating a glowing Jackبررسی تکنیک  : جلسه شانزدهم 

 استفاده از ابزارRefine Mask 
ایجاد عمق در تصاویر قرینه 
استفاده از گرادینت و ایجاد سایه توسط آن 
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 ink drawingبررسی تکنیک  :جلسه هفدهم 

 استفاده از  فیلتر(Blur->Gaussian )و نحوه ست کردن تنظیمات آن 
 معرفی و کار با فیلتر(Blur -> Smart Blur) 
 استفاده از  فیلتر(Other->High Pass )و نحوه ست کردن تنظیمات آن 
 معرفی و کار با فیلتر(Sketch -> Note Paper) 
 معرفی ابزارLevel  
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 معرفی و کار با فیلتر(Other -> Offset) 
 نحوه ذخیره اگو(Pattern)   ایجاد شده و چاپ آن در مقیاس بزرگتر 
 بررسی پنلPattern    نحوه درج الگو(Pattern) ایجاد شده در سند جدید 
 نحوه تغییر مقیاس سند چاپی توسط پنلCanvas 
 نکاتی در مورد چند ترفند کاربردی 
بررسی چند ترفند ساده ولی کاربردی برای اصلاح برای تکرار منظم طرح ها 
 ایجاد سایه توسط ابزارGradient 

 
 برای مشاهده بهتر نتیجه کار روی تصویر سمت راست کلیک کرده و آن را بزرگ کنید

 

 و نحوه ایجاد کاغذ کادو  repeating patternبررسی تکنیک :جلسه هجدهم 
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 معرفی و کار با پنلParagraph  برای تنظیمات متون 
 معرفی  و استفاده از ابزارColor Sampler Tool 
نحوه جداسازی بک گراند از تصویر مورد نظر 
 استفاده از ابزارClipping mask 

 Rendering a portrait in type               بررسی تکنیک : جلسه نوزدهم 
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نحوه جداسازی بک گراند از تصویر مورد نظر 
 استفاده از ابزارClipping mask 
 اعمالPattern  دلخواه روی تصاویر 
 استفاده از ابزارColor Overlay  برای تغییر رنگ قسمتی از تصویر 

 Rendering a portrait in tile patterns             بررسی تکنیک : جلسه بیستم 
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 استفاده از فیلترBlue->Gaussion Blur    
 بررسی و استفاده از فیلترRender->Diffrence Clouds 
 رسم خطوط مورد نظر توسط ابزارbrush 
 استفاده از فیلترNoise 
 استفاده از فیلترMotion blur 

  synthetic lightningبررسی تکنیک  : جلسه بیست و یکم 
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 ایجاد شبکه بندی توسط پترنGriad 
 بررسی و استفاده از فیلترBlur->Radial Blure 
 ایجادLayer Mask  برای نمایان سازی بخش های جدا شده 

 explodeبررسی تکنیک  : جلسه بیست و دوم 
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 remove backgroundبررسی تکنیک    :جلسه بیست و سوم 

 بررسی و نحوه استفاده از ابزارQuick Selection Tool 
 بررسی و استفاده از ابزارRefine Edge 
نحوه برش تصاویر جدا شده از بک گراند 
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 کار با ابزارRefine Mask  
جداسازی تصویر از پس زمینه 
 نحوه بارگذاریBrush  دلخواه در نرم افزار 
 معرفی و کار با ابزارLiquify 
 کار باMask Leyer  ها 

  Dispersion Pixel Effectبررسی تکنیک  : جلسه بیست و چهارم 
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 معرفی و استفاده از ابزارColor Range 
 استفاده از مدل رنگMidtone 
 ایجاد براش ازText 

 
 
 

 body in textبررسی تکنیک  : جلسه بیست و پنجم 
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 معرفی و استفاده از ابزارBrightness/Contrast 
 استفاده ازBlend mode->Saturation 
 استفاده ازBlend mode->MultiPly 

 
 
 

 in face   textureبررسی تکنیک : جلسه بیست و ششم 

82 



 معرفی و استفاده از ابزارPen tool 
 معرفی براشInk Splatter  
 معرفی و استفاده از ابزارCurves  برای کار 
با تونالیته رنگ ها 
معرفی ترفند برای ایجاد نور 

 
 
 

 splash cutبررسی تکنیک : جلسه بیست و هفتم 
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 معرفی براشWater splash  
 استفاده از ابزارCurves  برای کار 
با تونالیته رنگ ها 
بار توسط ابزار  نحوه ایجاد سایه اینBrush 
بار توسط ابزار  نحوه ایجاد نور اینBrush 
 معرفی و استفاده از ابزارRectangle 

 
 
 
 

 water bubbleبررسی تکنیک : جلسه بیست و هشتم 
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معرفی و نصب پلاگین مورد نظر 
بررسی تنظیمات آن 
کار با رنگ ها در تصویر 
 بررسیBlande Mode->Hue 
 بررسیBlande Mode->color 

 
 
 
 

 glowبررسی تکنیک : جلسه بیست و نهم 
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 نحوه جدا سازی رنگ های متضاد از پس زمینه توسطChannel RGB 
 نحوه ترسیم اشکال موردنطر بصورتHand Drawing 
 بررسی فیلتر    Other->Minimum  جهت پر کردن نواحی خالی اطرف شی مورد نظر توسط رنگ

 داخلی شی
 بررسی تکنیکGuide Layer Mask    برای ایجاد طرح ها و افکت های مورد نظر در لایه جداگانه و

Mask  کردن آن در لایه مورد نظر 
 بررسی فیلترTexture->Grain 
 استفاده از فیلترNoise->Median 

 
 
 
 

 Drawing in photoshop:  جلسه سی ام
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 توضیح واستفاده ازBland Mode->screen 
 توضیح و استفاده ازBland Mode->Overlay 
 کار باMask Layer  ها برای محو تصاویر 
نحوه استفاده از تصاویر ترکیبی 

 
 
 

 ایجاد بک گراند و پوستر توسط تصاویر  : جلسه سی ویکم
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 توضیح واستفاده ازBland Mode->Screen 
 توضیح و استفاده ازBland Mode->Overlay 
 کار باMask Layer  ها برای محو تصاویر 
 استفاده از براشSmoke   وPaint 

 
 
 

 ایجاد بک گراند و پوستر توسط تصاویر و براش ها: جلسه سی و دوم
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 فصل سوم
 

 
 

 

 

 
 

 بررسی مباحث مرتبط با عکاسی و پردازش تصاویر
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 بررسی پنلBlack and White  برای تبدیل تصاویر رنگی به سیاه و سفید 
 معرفی واستفاده از ابزارTool Dodge برای ایجاد سایه های روشن 
معرفی واستفاده از ابزارTool burn برای ایجاد سایه های تیره و انعکاس نور 
 استفاده از Blend mode->color   و توضیح دو مورد کاربر آن 
 معرفی ترفند تغییر پس زمینه تصاویر توسط ابزارهایBlend mode Gradient , وLosso 

Tool  
 

 High key, high contrastبررسی تکنیک :جلسه اول 
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 معرفی و استفاده از ابزارRed Eye Tool 
 معرفی ابزارcalculations   برای پردازش ابزارColor Channel 
 معرفی و کار با ابزارChannel Mixer 
 معرفی و استفاده از ابزارFade Gaussion Blure 

 

 (رفع قرمزی چشم های در تصاویر دوربین ها ) Correcting red-eyeبررسی تکنیک  :جلسه دوم 
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  استفاده از ابزارHide Healing Brush Tool  
 بررسی پنلCLONE SOURCE 
 بررسی نحوه زاویه و عمق دادن به بخش های قریینه سازی شده برای هر چه طبیعی تر جلوه

 دادن تصاویر

 

 Healing Eyeبررسی تکنیک  : جلسه سوم 
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 نحوه تبدیلFlat Background   بهFloatting Background   
 معرفی و استفاده از ابزارSpot Healing Brush 
 معرفی و استفاده از ابزارClone Stamp Tool 
 استفاده از ابزارSmudge Tool 

 

حذف افراد مورد نظر از  -بخش اول  Removing people from a photo -  بررسی تکنیک: جلسه چهارم 
 تصاویر
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 استفاده از ابزارColor Range برای شبیه سازی قسمت های حذف شده 
 استفاده از فیلتر(Noise->Median) برای حذف لبه های زائد تصویر 
 استفاده از ابزارColor Range    برای شبیه سازی و باز گرداندن بخش های حذف شده از چهره

 ها در تصویر
 استفاده از ابزارSmudge Tool برای حالت دادن به اشکال مختلف در تصویر 

 

 شبیه سازی تصویر –بخش دوم   Removing people from a photo -  بررسی تکنیک: جلسه پنجم 
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 بررسی روشHand masking   توسط ابزارBrush   وSmudge 

 Hand Masking –بخش سوم   Removing people from a photo -  بررسی تکنیک: ششم 
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 بررسی منویModify->Contrast 
نحوه ایجاد بک گراند از یک لایه 
   نحوه فعال کردن و استفاده از منوی 
استفاده ازافکت ها 

 (ایجاد قاب عکس)Creating a vanity frame -   بررسی تکنیک: جلسه هفتم
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 معرفی و استفاده از ابزارColor-Range->skinTones 
 معرفی ابزارSponge Rainbow 
 معرفی و استفاده از ابزارQuick Selection Tool 
 معرفی و استفاده از ابزارModify->Feather 
 معرفی و استفاده از ابزارVibrance 

 -white teeth and  Achieving silky smooth skin with retouching –بررسی تکنیک : جلسه هشتم
 و سفید کردن دندان ها  روتوش تصاویر
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 بررسی منویLab Color  
 بررسی خاصیتLab Mode 
 بررسی منویShadows/Highlights  
 استفاده ازBlend mode->luminosity 
 قرار دادن دوSmart Object  درون یکدیگر 
 استفاده از فیلتر(Sharpen->Smart Sharpen) 

 بخش اول– Effect  faux HDRبررسی تکنیک : جلسه نهم 
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 معرفی و استفاده از ابزارPolygonal Lasso Tool  برای انتخاب قسمت های مورد نظر در تصویر 
 معرفی و استفاده از ابزارCopy Merged 
 استفاده از دستورGradient Map 
نحوه ایجاد و وارد کردن فایل های گرادینک از قبل ایجاد شده 

 بخش دوم – Effect  faux HDR بررسی تکنیک : جلسه دهم 
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 نحوه ایجاد گرادینت سفارشی 
 تلفیق تصاویر توسط فیلتر(Blur->Gaussian) 
 نحوه ایجاد وانتخاب نواحی ثابت توسط ابزارRecatangular 

  synthetic rainbow      بررسی تکنیک: جلسه یازدهم 
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 کار با پالت رنگHue/saturation 
 کار با ابزارColor Range   و ایجادMask Color 
 استفاده از Blend mode->Hueبرای ایجاد رنگ طبیعی تر 

 

 بخش اول -Changing the colorبررسی تکنیک  :جلسه دوازدهم 
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 کار با پنلChannel 
 بررسی منویApplay Image 
محیط در تصویر مورد نظر بررسی نحوه انعکاس نور اجسام 

 

 Solidایجاد رنگ های –بخش دوم  – Changing the colorبررسی تکنیک  :جلسه سیزدهم 
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 معرفی و استفاده از ابزارPolygonal Lasso Tool   برای انتخاب قسمت های مورد نظر در
 تصویر

 معرفی و استفاده از ابزارCopy Merged 
 استفاده از دستورGradient Map 
نحوه ایجاد و وارد کردن فایل های گرادینک از قبل ایجاد شده 

 

  Miniaturizing      بررسی تکنیک: جلسه چهادهم
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 معرفی و استفاده از ابزارSpot Healing Brush Tool 
 معرفی و استفاده از ابزارPatch Tool 
 استفاده از دستورFill->content-Aware 
نحوه ایجاد و وارد کردن فایل های گرادینک از قبل ایجاد شده 

 

  Restoring old images      بررسی تکنیک : جلسه پانزدهم
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 معرفی و استفاده از ابزارColor Replacment Tool    
 استفاده از ابزارRefine Edge 
  استفاده از ابزارPolygonal lasso tool 

 بخش اول - colorize images  بررسی تکنیک: جلسه شانزدهم
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 معرفی و استفاده از لایه هایColor Solid   
 استفاده از ابزارRefine Edge 
 بررسیQuick Mask Layer 

 بخش دوم - colorize old images  بررسی تکنیک: جلسه هفدهم

106 



 بررسی نحوه ایجادColors Layer  و ایجاد طرح رنگ اولیه تصویر 
  استفاده از ابزارColor Range  برای انتخاب رنگ مورد نظر 
 افزایشContrast   تصویر توسط ابزارLevel   برای ایجاد تضاد و تفکیک بهتر رنگ های

 سیاه و سفید
 بررسی Blend Mode  های گوناگون برای رسیدن به بهترین تونالیته رنگ مناسب و استفاده

 Blend Mode->colorاز 
 بررسی نحوه کاهش روشنایی تصویر توسط ابزارunderling Layer   

 
 

 بخش سوم - colorize images  بررسی تکنیک: جلسه هجدهم
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 استفاده از ابزارCanvas Size 
بررسی ترفند هم پوشانی محل اتصال دو تصویر 
  بررسی ترفند ایجاد انعکاس طبیعی تصویر 

   reflection    water emerge بررسی تکنیک: جلسه نوزدهم
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 بررسی ابزارAdobe Camera Raw  
 بررسی نحوه ایجاد افکت های متنوع روی تصاویر همچون اپلیکیشن هایی مانندInstagram 

 Filtering images with Camera Raw  بررسی تکنیک: جلسه بیستم 
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استفاده از فیلتر  other->High Pass 
استفاده از فیلتر  Sharpen->unsharp mask 
استفاده از فیلتر  Noise-> Add Noise 
 بررسیblande mode->Vivid Light  
 ایجاد تصاویرHDR   توسط فیلترCamera Raw 

 

  hdr effect  بررسی تکنیک: جلسه بیستم و یکم
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 فصل چهارم
 

 

 

 

 

 

 
 

  (3D)بررسی مباحث سه بعدی  
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 معرفی و کار با فیلتر(Noise-> Add Noise) 
 معرفی و کار با فیلتر(Render-> LensFare) 
 استفاده از Blend mode->linear Dodge    برای تلفیقGradient   های سفارشی با فیلتر

 ها
 تلفیق کردنCliping mask   در لایه ها 

و ایجاد تصویر پس زمینه توسط ابزار جدید فتوشاپ با نام  synthetic star field: جلسه اول 
Repousse  
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 نحوه تغییر ابعاد تصاویر توسط ابزارImage Size 
  3معرفی  منویD->repousse  بعدی3بعدی به متن  2نحوه تبدیل متن 
 3معرفی جعبه  ابزارD   و استفاده از ابزارObject Rotate Tool 
 معرفی ابزارSlide 3D Object  
 معرفی ابزارDrag 3D Object  
  معرفی پنلDrag 3D Scene   واستفاده از ابزار های موجود در آن 
 نحوهRender   کردن و استفاده از ابزارRay Traced Draft     برای از بین بردن شکستگی

 لبه ها و خمیدگی ها در  تصاویر سه بعدی ایجاد شده,خطوط 

بعدی توسط ابزار جدید فتوشاپ با نام  3برای ایجاد متون  3D type بررسی تکنیک : جلسه دوم 
Repousse    در ورژنCS5,CS6 EXTENDED   
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 معرفی  منوی->Selected Path 3D->repousse  
 بعدی3نحوه افزودن و لود کردن رنگ های بیشتر برای عناصر 
  نحوه تغییر رنگ عناصر و سایه ها توسط ابزارهای 

 Rectangle Front infection Material 
 Rectangle Front Bevel Material 
 Rectangle Extrusion Material 

 3 استفاده از ابزارD Object Pan Tool  در صفحه  بعدی3حرکت دادن اشیاء 
 3بعدی نظیر 3نحوه غیر فعال سازی مخفی شدن لایه ها در هنگام کار با ابزارهایD Object Pan Tool 
  بررسی منویMarge 3D Layers   3برای ادغام لایه ها در مبحثD 
 3بررسی پنلD(Mesh)   3و استفاده از ابزارD Mesh Slide Tool  برای حرکت اشیاء درون یکدیگر 

بعدی و  3و کار با سایه ها  و انعکاس آن در عناصر    3D type (Repousse)  ادامه: جلسه سوم 
 استفاده از افکت های ایجاد شد در عناصر جدید
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 بررسی ابزارInfinite Lights 
 نحوه استفاده از ابزارLight Rotate Tool 
 3بررسی پنلD(LIGHTS) 
 معرفی و کار با  منویLight Type 
نحوه نرم کردن لبه های سایه شی مورد نظر 
 نحوه حرکت دادن نور در عمق و جهات مختلف    (orientation) 

و کار با نور  و انعکاس آن در    3D type (Repousse)بررسی تکنیک     ادامه: جلسه چهارم 
 بعدی و استفاده از افکت های ایجاد شد در عناصر جدید 3عناصر 
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 بعدی و نحوه کارکرد عینک های سه بعدی  3مروری بر تصاویرAnaglyph 
نحوه تهیه و نوع عکاسی مناسب برای ایجاد تصاویر سه بعدی 
 کار روی تصاویر مورد نظر و ویرایش آنها در نرم افزارAdobe Bridge 
انجام تنظیمات رنگ تصاویر برای تبدیل آنها به تصاویر سه بعدی 
ایجاد متون سه بعدی 
بررسی تنظیمات ایجاد فرورفتگی متون در تصویر 
بررسی تنظیمات ایجاد برجستگی متون در تصاویر 
بررسی قواعد و ترفند های کلی این تکنیک 

 
که دارای یه شیشه یا تلق آبی و یک شیشه   Anaglyphبرای درک بهتر نتیجه کار تصویر زیر رو با یک عینک 

 یا تلق قرمز رنگ هست نگاه کنید
 
 

 تصاویر در اسلاید بعدی در دسترس می باشد

ایجاد تصاویر سه بعدی با قابلیت دیدن آنها با -  stereoscopicبررسی تکنیک :جلسه پنچم 
ایجاد متون سه بعدی و بررسی قواعد نحوه دادن عمق و  -  anaglyphعینک های سه بعدی 

 برجستگی به متون
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   anaglyphنمونه هایی از عینک های 
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(1)تصاویر سه بعدی   

118 



(2)تصاویر سه بعدی   
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 فصل پنجم

 
 
 
 

 
 
 

  و بنر در فتوشاپ  اصول و مبانی طراحی قالب
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اهداف من برای طراحی یک قالب چیست؟ 
روانشناسی رنگ در وب چیست؟ 
اصول انتخاب صحیح رنگ ها متناسب با کاربرد وب سایت ها 
  بررسی و معرفی انواع متدهای استفاده از رنگ در وب 

 Hexadecimal 
 RGB 
 HSL 

بررسی امکانات پالت انتخاب رنگ 
بررسی شیوه جدید طراحی قالب با عنوان طراحی فلت 
 طراحی فلت(Flat) چیست؟ 
 طراحی رئالیسم(Realism) چیست و بررسی معایب آن؟ 
 تفاوت طراحی رئالیسم و فلت 
مثالی در مورد طراحی رئالیسم 
بررسی مزایا و معایب ناچیز آن و دلایل محبوبیت و استفاده از طراحی فلت ؟ 
قوانین طراحی قالب فلت 
مفهوم اسناد وب و ایجاد صحیح یک سند گرافیگی مخصوص وب 
نحوه ی استاندارد چیدمان عناصر و بخش ها در یک قالب وب سایت 

 

  فتوشاپطراحی قالب وب سایت در 
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معرفی انواع واحدهای اندازه گیری و انتخاب صحیح واحد اندازه گیری 
مفهوم رزلوشن و انتخاب رزلوشن صحیح در نرم افزار برای ایجاد یک قالب 
 معرفی و استفاده از ابزارRuler و بررسی تنظیمات آن 
 معرفی و استفاده از ابزارGuideline و بررسی تنظیمات آن 
هدر فوتر دکمه ها باکس ها اسلایدر ها تب ها فیلد ها منوها اصول و طراحی لوگوه... 
 یا به اصطلاح ( بنر هاب تبلیغاتی)اصول و طراحی تصاویر متحرکgif 
معرفی اندازه های استاندارد جهت استفاده و ایجاد بنر های تبلیغاتی 
معرفی سایت های آنلاین برای انتخاب و ست کردن رنگ ها 
 معرفی پلاگین مرورگر فایر فاکس برای تبدیل تصاویر با رنگ گرادینت به کدهای هگزا

 ( تبدیل تصاویر رنگی به کدهای رنگ)رنگ
 استفاده از پلاگین مذکور برای تبدیل رنگ هایsolid  و گرادینت تولید شده به فرمت های 

 Hexadecimal 
 RGB 
 HSL 

 
 

 طراحی قالب وب سایت در فتوشاپ
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استخراج رنگ های بکار رفته در یک وب سایت توسط پلاگین مذکور 
 انواع رنگ های جامدSolid   وGradient و نحوه ی ایجاد و استفاده از آنها 
تصویر در طراحی وب 
نحوه ی صحیح ذخیره سازی و بهینه سازی تصاویر برای استفاده در وب 
انواع پسوندهای ذخیره سازی تصویر برای استفاده در وب 
  نحوه صحیح استفاده از تصاویر ، پترن ها و رنگ ها بعنوان پس زمینه ی قالب گرافیکی وب

 سایت
 مفهوم شفاف بودنTransparent و استفاده از تصاویر شفاف در طراحی 
برش زدن قالب گرافیکی وب سایت 
مفهوم برش زدن و ضرورت برش زدن قالب گرافیکی 
معرفی و استفاده از ابزار های برش 

 Crop Tool 
 Perspective Crop Tool 
 Slice Tool 
 Slice Select Tool 

 طراحی قالب وب سایت در فتوشاپ
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نحوه ذخیره سازی و خروجی گرفتن  برش های قالب 
متنون در طراحی قالب گرافیکی 
سایز مناسب و استاندارد متون در قالب گرافیکی و وب 
 (ایجاد سایه ها و )جلوه های ویژه و افکت های مناسب برای متون در طراحی رئالیسم... 
استفاده صحیح از فونت های مناسب و معرفی انواع فرمت های مناسب برای استفاده در قالب 
رایج و پرکاربرد در وب,معرفی فونت های مناسب 
Mockup چیست ؟ 
معرفی سایت های آنلاین برای طراحی اولیه قالب(mockup) 
معرفی سایت هایی برای دریلفت آیکون های مورد نیاز 
بعد از طراحی قالب چه کار هایی یابد انجام دهیم 
نحوه استخراج فونت های بکار رفته در وب سایت مورد نظر شما 
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 پروژه عملی مطابق با استاندارد های روز  3انجام: 

 
 

 تبلیغاتیبنر متحرک طراحی 1.
 

 طراحی قالب و رابط کاربری وب سایت 2.
 

 قالب برای بخش مدیریت وب سایتطراحی 3.
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 جامعترین سرفصل های ممکن 
ساعت آموزش ویدیویی با کیفیت 70  

 
 

 
 
 

!هزینه کلاس های حضوری یک سوم فقط با   
 همین الان ثبت نام کنید
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